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End User License Agreement
This is a legal agreement between you, the end user, and Gaumard Scientific
Company, Inc. (“Gaumard”). This software is protected by copyright laws and
remains the sole property of Gaumard. By installing the UNI (the "Software")
media, you agree to be bound by the terms of this agreement. If you do not agree
to the terms of this agreement, promptly return the uninstalled media and
accompanying items to Gaumard at the address indicated below.
1. Grant of License. Gaumard hereby grants to you (an individual or institution)
the right to install and activate the Software on one computer for use with one
Interactive patient simulator system. The software may also be installed on any
number of other computers at the same institution so that students may access
the learning resources. One copy of the software may be made for backup
purposes. You may not network this Software, or allow multiple users unless you
purchased a multi-user workstation license. Sharing this Software with other
individuals or allowing other individuals to view the contents of this Software is in
violation of this license.
2. Copyright. The Software is owned by Gaumard and protected by United States
copyright laws and international treaty provisions. Therefore, you must treat this
Software like any other copyrighted material. You may not make this Software or
copies thereof available in any manner or form or use, copy or transfer the
Software, in whole or in part, except as provided herein.
3. Other Restrictions. You may not rent or lease this Software to any other party.
You may not alter, merge, modify, adapt, reverse engineer, decompile or
disassemble the software, or disclose the contents of this Software to any other
party.
4. Electronic Transmission of Software. If you received the Software by electronic
transmission or by Internet delivery, by installation of the Software, you
acknowledge that you have read and understand this license agreement and
agree to be bound by its terms and conditions.
5. Term of Agreement. The term of this Agreement and the license granted to
you pursuant hereto shall commence upon installation of this Software. This
Agreement and the license granted herein may otherwise be terminated by
Gaumard in the event that you are in breach of any provision of this Agreement.
In the event of termination, you agree to immediately return this Software,
accompanying items, and any copies thereof to Gaumard.
6. LIMITED WARRANTY
(A) THE CD-ROM MEDIA (THE "MEDIA") WHICH CONTAINS THIS
SOFTWARE IS WARRANTED, FOR A PERIOD OF 30 DAYS FROM THE DATE
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OF PURCHASE, TO BE FREE FROM DEFECTS IN MATERIAL AND
WORKMANSHIP. ELECTRONIC TRANSMISSION IS WARRANTED TO BE
FREE FROM DEFECTS AT THE MOMENT OF TRANSMISSION. YOUR SOLE
AND EXCLUSIVE REMEDY, AND GAUMARD'S SOLE LIABILITY, IS TO
REPLACE THE DEFECTIVE MEDIA OR TO REPEAT THE ELECTRONIC
TRANSMISSION PROVIDED THAT YOU NOTIFY GAUMARD IN WRITING OF
SUCH DEFECT OR DEFECTIVE TRANSMISSION AND RETURN THE
DEFECTIVE MEDIA, IF ANY, DURING THE 30-DAY WARRANTY PERIOD.
(B) EXCEPT AND TO THE EXTENT EXPRESSLY PROVIDED IN PARAGRAPH
(A), THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS ARE
PROVIDED ON AN "AS IS" BASIS, WITHOUT ANY WARRANTIES OF ANY
KIND, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. NO
ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY GAUMARD, ITS
DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A
WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY,
AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE.
GAUMARD DOES NOT WARRANT, GUARANTEE, OR MAKE ANY
REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF USE, OF
THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS,
ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE, AND THE
ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE
SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE OR WRITTEN
MATERIALS ARE DEFECTIVE, YOU AND NOT GAUMARD OR ITS DEALERS,
DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST
OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION OTHER THAN
EXPRESSLY DESCRIBED ABOVE.
(C) NEITHER GAUMARD NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN
THE CREATION, PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL
BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL OR
INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION,
AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH
PRODUCT OR RELATED TO THIS AGREEMENT EVEN IF GAUMARD HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. GAUMARD
SHALL NOT BE LIABLE TO YOU FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES OR LOST PROFITS ARISING
OUT OF OR RELATED TO THIS AGREEMENT OR YOUR USE OF THE
SOFTWARE AND/OR THE RELATED DOCUMENTATION, EVEN IF GAUMARD
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO
EVENT SHALL GAUMARD'S LIABILITY HERE UNDER, IF ANY, EXCEED THE
PURCHASE PRICE PAID BY YOU FOR THE SOFTWARE.
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ALL RIGHTS NOT EXPRESSLY GRANTED IN THIS LICENSE AGREEMENT
ARE RESERVED BY GAUMARD.
ACKNOWLEDGMENT

BY INSTALLATION OF THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ AND UNDERSTAND THE FORE GOING AND THAT YOU AGREE
TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT
THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF
AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL PROPOSED
OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE LICENSE
DESCRIBED HEREIN.
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Care and Cautions
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Overall Warnings
Remember that damage caused by
misuse is not covered by your
warranty. It is critical to understand
and comply with the following
guidelines. Additional warnings are
found throughout the documentation
If the simulator will not be used for
an extended period, re-charge the
battery at least once every 60 days
to prevent damage.
Do not attempt to intubate without
lubricating the airway adjunct with a
silicone oil lubricant (provided).
Failure to do so will make intubation
very difficult and is likely to result in
damage.
NEVER disconnect the
communications module while the
UNI software is running. The
software will halt, and the module
may be damaged.
When simulating drug administration
via endotracheal tube, providers
must use an empty syringe. Passing
liquids into the trachea or esophagus
may cause internal damage.
Premie HAL should be cleaned with
a cloth dampened with diluted liquid
dishwashing soap. If medical
adhesives remain on the skin, clean
with alcohol wipes. DO NOT USE
“GOO GONE” as the citric acid in
the formula will cause pitting of the
various materials comprising your
simulator.

cause the simulator to soften and
slowly warp. It is acceptable to
operate Premie HAL at an ambient
temperature of 95 degrees
Fahrenheit (35 Celsius).
Premie HAL is "splash-proof" but not
water-proof. Do not submerge or
allow a large volume of fluid to enter
the interior of the simulator. Do not
expose the tablet computer to water
or excessive dust unless it is
protected by a rugged case
(available separately).
Mouth to mouth resuscitation without
a barrier device is not
recommended, as it will contaminate
the airway. Treat Premie HAL with
the same precautions that would be
used with a real patient.
The use of needles larger than 22
gauge will reduce the lifetime of the
lower arms' skin and veins.
When the arm veins require
replacement, contact Gaumard to
arrange for a lower arm exchange.
Refer to the Consumables and
Replacement Parts section of this
guide, and contact customer service
for more information.
Do not inject fluids into the
intramuscular sites. Intramuscular
sites are for placement exercises
only.
Do not remove or replace the
umbilical cord while Premie HAL is
in operation. Doing so will cause
damage to the system.

Store Premie HAL in a cool, dry
place. Extended storage above 85
degrees Fahrenheit (29 Celsius) will
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Do not pull or carry the simulator by
the limbs. Handle Premie HAL with
the same care as a human patient.

Conductive Sites
Premie HAL’s conductive skin sites
allow the attachment of real EKG
electrodes. This feature permits the
user to track cardiac rhythms with
their own equipment just like with a
human patient. A few special
concerns are described below.
Premie HAL does not accept real
electrical therapy. Do not pace or
defibrillate Premie HAL with real
electrical equipment.

The Gaumard User Interface
features a virtual electrical therapy
function to simulate defibrillation or
pacing.
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Getting Started
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Overview
GENERAL















Tetherless and fully responsive
even while being transported
Powered from an internal
rechargeable battery or wall
outlet using power adapter
Battery capable of 300
recharges and
Simulator receives commands
from a wireless tablet PC and
operate at distances up to 150
feet
Option to operate automatically
using Automatic mode or
manually by the Instructor
Training Guide with both basic
and advanced interactive
scenarios
Use pre-programmed scenarios,
modify them or create your own
quickly and easily
Installation and training
worldwide
Simulation Made Easy TM

AIRWAY





Oral and nasal intubation
Use an ET tube or LMA
Unilateral chest rise with right
main stem intubation
Multiple upper airway sounds
synchronized with breathing

APPEARANCE


Color responds to hypoxic
events and interventions
(healthy, mild cyanosis, severe
cyanosis)
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BREATHING










Control rate and depth of
respiration and observe chest
rise
Ventilation is measured and
logged
Select independent left and right
lung sounds
Chest rise and lung sounds are
synchronized with selectable
breathing patterns
Accommodates assisted
ventilation, including BVM and
mechanical support
Unilateral chest rise

CIRCULATION










Conductive skin regions allow for
ECG monitoring with real
equipment
Multiple heart rhythms, rates and
complications
Heart sounds include a normal
heart as well as atrial and
ventricular septal defects
Chest compressions are
measured and logged
Palpable fontanelle, brachial,
femoral, and umbilical pulse
sites
Pulse strengths vary with blood
pressure and pulses are
synchronized with ECG

SIMULATOR






Internal rechargeable NiMH
battery
Venous access
Bilateral IV training arms
Patent umbilicus
Intraosseous access at tibia

CONTROL




Wireless tablet PC with stylus
control
Communication modules are
FCC and CE Compliant
Communications module can be
used simultaneously with the
tablet computer's integrated
wireless (IEEE 802.11b)
networking device

ACCESSORIES






100-240 VAC Charger
Power supply adapter
Battery Charger
Instructions
Carrying case

OTHER




One year limited warranty,
extended warranty to three years
option
Installation and training services
available
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Terminology
It is wise to spend a moment
familiarizing yourself with some of
the terminology that will be used to
discuss simulation with the Premie
HAL system.
Automatic Mode - In this mode, vital
signs respond automatically to
caregiver participation, instructor
specifications, and pharmacologic
intervention. The model used in this
operating mode was developed
based on physiologic principles.
Features unique to this mode
include: a comprehensive list of
drugs for easy administration, a drug
profile editor for adding new drugs or
editing existing ones, among other
things.
Facilitator - the person conducting
the simulation; an instructor or lab
staff member.
GUI - the Gaumard User Interface is the software application, used to
control the simulator and evaluate
care providers.
Palette - a collection of Palette
Items. Each profile has its own
palette.
Palette Item - Any full or partial set
of physiological parameters that
have been grouped and saved
together under a single name.
Profile - a unique Premie HAL
software configuration, including
custom Palette, Scenarios, and
options. Each Profile acts as a
separate program, in that changes
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made to one profile have no effect
on the others.
Provider - a person participating in
the simulation as a healthcare
provider.
Scenario - a saved sequence of
physiological states, like a "playlist."
Scenarios provide a level of
automation that unburdens the
facilitator and allows standardized
presentation of symptoms.
Scenario Item - a Palette Item that is
part of a scenario. Scenario Items
may also represent a fixed delay
period ("Wait") or a pause ("Wait
Indefinitely").
Stylus - a special pointing device for
the tablet computer. The stylus is the
fastest and easiest means of
controlling the Premie HAL software.
See the Equipment Set-up section of
this guide for more information on
working with the stylus.

Equipment Set-up
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Control Tablet
Computer
The touchscreen tablet computer
serves as the simulator’s control
center. Startup and control
commands are sent from the
Gaumard control software (UNI) to
the simulator wirelessly using the RF
communication module shown in the
next section.
Please refer to the computer’s
documentation for important user
and safety information before
powering on the tablet computer for
the first time.

four corners of the screen. Position
yourself and the tablet as if you are
working, and carefully touch the
exact center of each of the targets.
After calibration, the pointer should
be displayed directly beneath the
stylus tip. Significant changes to
viewing angle should be followed by
calibration for best performance.

Communication Module
Connect the RF communication
module to an available USB port on
the tablet’s/PRO+ left side.

USING THE STYLUS
The stylus operates very much like a
mouse. You will notice that the
pointer moves when the stylus is
held near, but without touching the
screen. Tapping the screen with the
stylus tip is like clicking the primary
(usually left) mouse button. Holding
the stylus button while tapping the
screen is like clicking the secondary
(usually right) mouse button.

Secure the RF communication
module to the tablet or PRO+
computer using the Velcro patch.

CALIBRATING THE STYLUS
For working with the Gaumard
control software and many other
applications, the stylus input is far
superior to a mouse in both speed
and comfort. An additional
advantage is it can be easily
calibrated for your personal comfort.

The calibration utility found in the
control panel will present the user
with crosshair targets at each of the
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The tablet is now ready to
communicate with simulator.
Warning: Never disconnect the
communications module while the

Premie HAL software is running.
Doing so can seriously damage
the module.

Premie HAL
Battery
Premie HAL (S/N p6009067 or
higher) includes two separate power
adapters labeled “Premie HAL
Charger” and “Premie HAL Power
Supply”. Before using the simulator
for the first time, reference the use
for each adapter below.
CHARGING THE BATTERY
To charge the battery, connect the
adapter labeled “Premie HAL
Charger” to the battery port and
charge Premie HAL for 2-3 hours (or
until the charger displays a green
light). The charger indicator light will
show red during the charge period
and green once the process is
complete.
The simulator’s battery
charges only when the control
software is disabled.

is connected, the battery will not
charge. To charge the battery you
must:
1. If connected, unplug the charger
adapter from the simulator and
the wall outlet.
2. Turn off the simulator by closing
the UNI control software.
3. Re-connect the charger adapter
to the wall outlet and the
simulator’s battery port.
4. Leave the simulator charging for
2-3 hours with the UNI control
software disabled.
BATTERY LIFE
Premie HAL has a maximum battery
runtime of approximately 2 hrs. Total
runtime is dependent on factors
such as breathing rate and sounds.
The battery status is displayed on
the software status panel after the
connection with the simulator is
established. For more information
about the battery indicator, refer to
“Working with UNI” section.
Warning: If the simulator will not
be used for an extended period,
re-charge the battery at least
once every 60 days to prevent
damage to the internal battery.
USING THE POWER SUPPLY
(SYSTEM S/N p6009067 OR
HIGHER)

Avoid using the simulator while the
battery charger is connected. If the
simulator is in use while the charger

The power supply adapter allows the
simulator to operate through long
simulations sessions by drawing
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power from the wall outlet and not
battery reserve. Use the power
supply for simulation sessions
lasting 2 hours or more. If simulation
sessions are shorter than 2 hours,
use the simulator’s battery reserve.
The power supply adapter will
NOT re-charge the battery.
Avoid using the power supply
adapter when the simulator’s
battery is completely depleted.
To use the power supply adapter:
1. Fully charge the simulator’s
battery using the “Charger”
adapter.
2. Disconnect the “Charger” and
connect the “Power Supply”
adapter.

Virtual Monitor
The optional virtual patient vital sign
monitor system works with UNI to
receive and display the simulator’s
vital sign information. The system
includes an all-in-one touchscreen
computer and the Gaumard Virtual
Monitor software.
EQUIPMENT SETUP

Please refer to the documentation
included with the all-in one computer
for important safety, installation, and
start-up information. Secure all the
system’s connection and power on
the touchscreen computer as
indicated by the product’s
documentation.
WIRELESS AD-HOC
CONNECTIVITY

3. Activate the UNI software.
4. The UNI battery icon will display
a lightning icon when the power
supply is connected.
Please contact Gaumard for
information on the power
supply upgrade for earlier
Premie HAL models.

The tablet and virtual monitor
computer automatically establish an
ad-hoc (computer-to-computer)
wireless connection at startup. The
wireless connection between both
systems allows UNI to update the
vital signs information displayed on
the Gaumard Monitors program.
To verify the connection between the
computers, click on the wireless icon
located on the task tray of both the
tablet and virtual monitor. For
troubleshooting information on the
ad-hoc connectivity, navigate to the
Appendix.
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The Gaumard Virtual Monitor
software is now ready to receive vital
sign information.

Gaumard Monitors
After the ad-hoc connection is
established, double click or tap the
Gaumard Virtual Monitors icon
located on the virtual monitor’s home
screen.

To learn more about the Gaumard
Monitors features and functionality,
click then V menu and select Help to
open a digital copy of the Gaumard
Virtual Monitor User Guide.
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Working with UNI
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Initializing the
Simulator

The simulator selection menu is
shown. Select Newborn HAL and
click “Start”.

After reading the manufacturer’s
care and caution information, press
the power button to turn on the
Tablet PC.

The UNI software initializes the
simulator. Double click the UNI icon
on the tablet’s home screen to start.

The wireless link between UNI and
the simulator is established within 1
minute.
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PROFILES AND OPERATING
MODES
After the startup screen, the profile
and operating mode selection menu
is displayed.

The Manual mode includes the
following profiles:
Default Profile – includes one
palette with healthy vital signs.
Quick Start Newborn HAL –
includes basic preprogrammed
scenarios
AUTOMATIC MODE
The UNI control software has two
modes of operation: Manual and
Automatic. Each mode includes a
Quick Start profile with
preprogrammed scenarios exercises
created in conjunction with
experienced healthcare instructors
and working medical professionals.
Continue to the next section to learn
more about the each operating
mode and the profiles included.

The Automatic mode assists the
facilitator by automatically adjusting
vital signs in response to caregiver
participation, pharmacologic
intervention, and manual input. For
example, when facilitator increases
the heart rate, the Auto mode will
calculate the response and adjust
the blood pressure automatically. To
activate the operating mode as an
upgrade option, go to the digital UNI
user guide.

After selecting an operating mode
and profile, click “Load” to continue.

MANUAL MODE
In the “Manual” operating mode, the
facilitator fully controls the vital signs
and physiologic responses.
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The Automatic mode includes the
following built-in profiles:
Default Modeling– includes one
palette with healthy vital signs.
Meds Profile – This profile contains
a library of pre-programmed drugs to
be used on simulations.
Quick Start Newborn Hal
Modeling – includes a library of
scenarios configured for the
Automatic operating mode
MANAGING PROFILES

Select the server location and click
“Make New Folder” to create the
profile folder.

Use the Manage Profile Menu to
create a new profile and edit this
profile.
In addition, the profile folder location
will be shown below the “New
Profile” icon.

Assign a name to the folder and click
“OK”

Use the “Map Profiles folder“ icon to
select the location of the new profile
to be created on the server.

The new profile folder location will
show up. Then proceed to create a
new profile, see instructions detailed
below.

Use the “Home” icon to reset to
default profiles folder.
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CREATING A NEW PROFILE

or making changes to this profile.

Profiles store palette, scenario, and
option settings independently;
changes made to one profile have
no effect on the others. Below are
some examples on how profiles are
used.

Lastly, click “Create” to save the new
profile



Assign one profile to each user
of your Gaumard simulator
system



Use profiles to organize and
protect palettes and scenarios



Create a profile dedicated to a
specific academic course taught
by multiple instructors



Devote an entire profile to one
particular subject area, or even
one particular scenario

Click “Rename” or “Delete” to
change the name of delete this new
profile.

For more information about the UNI
software, refer to the digital User
Guide under Menu/Help/Instruction
Manual.

To create a new profile, click “New
Profile”.

Enter a name for the new profile
followed by a description.

Enable the PIN protection to prevent
unauthorized users from accessing
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UNI Interface
The UNI software is used control the simulator, monitor the vital signs, and
evaluate the provider’s performance. The simulation technician or instructor
carrying out the simulation operates the UNI software
The UNI control elements and scenario programming procedures are consistent
throughout the Gaumard family of high fidelity simulators. Some software
controls and features covered in this guide may be hidden depending on the
simulator’s hardware configuration and optional upgrades.

CONNECTION STATUS
The communication indicator
displays the status of the radio link
between the tablet’s USB RF
module and the simulator. Full bars
indicate excellent communication
(i.e., normal operation).

BATTERY INDICATOR
The battery indicator displays the
battery charge information. An
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exclamation sign is shown when
there is no communication with the
simulator and battery information
cannot be retrieved.

When the battery icon is depleted,
the simulator is set to STAND-BY
mode automatically to protect some
of the simulator’s internal
components.

Simulator will not initialize until
connected to the charger or the
battery is replaced with a fully
charged spare.
WARNING

POWER/STAND BY
The power button is located at the
bottom right corner of the UNI
software. Toggle the power button to
set the simulator to stand-by mode
and then again to resume.

Turn Simulator OFF before
replacing the battery. Failure to
do so could result in serious
damage to the system.
Feature

Runtime

Internal Battery

Approx. 3 hours

SESSION CLOCK

For more information about the UNI
software, refer to the digital User
Guide under Menu/Help/Instruction
Manual.

The session timer displays the
duration of the current session. Click
the timer to reset the clock or to start
a new session. Event entries in the
text log are synchronized with the
session timer.
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Status / Details
Controls

controls displayed on the details tab
provide the simplest method for
controlling the simulator’s vital signs,
sounds, and features.

The Status/Details panel is used to
monitor and control the simulator’s
vital signs. The individual parameter
controls displayed on the details tab
provide the simplest method for
controlling the simulator’s vital signs,
sounds, and features.
The Status/Details tab displays the
vital signs controls in a list format.
SYSTEMS LIST VIEW

CHANGING VITAL SIGNS
To adjust numerical values click the
slider control. (e.g. heart rate, blood
pressure, respiratory rate, etc.).

Alternatively, use the keyboard for
manual entry and click the green
checkmark to confirm the change.

The Status/Details panel is used to
monitor and control the simulator’s
vital signs. The individual parameter
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To change patterns, sounds, and
rhythms, click on the specific control
to display the library (e.g. EKG
rhythms, heart and lung sounds,
respiratory patterns, etc.)

No changes will be made to the
simulator’s condition until the new
settings are submitted using the
“Apply” panel.

After the list of changes is created,
click “NOW” to update the vital
signs instantly. Alternatively, click
a trending timer to update
numerical vital sign parameters
(e.g. heart rate, blood pressure)
gradually.

Click the slider control below the
sound library to adjust the volume of
the sounds.

Vital sign parameters can be edited or
removed using the edit and remove
parameter tabs

APPLYING CHANGES
Enable the “instant apply” option and
click the control to change the vital
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sign to a new value without the need
to use “Apply” panel. Vital signs
undergoing change blink yellow.

CREATING PALETTE ITEMS
A palette item stores one or more vital
sign settings into a single loadable
object. Use a palette item to update a
set of vital signs quickly. For example,
one palette item can be created to
update all the cardiac parameters to a
healthy state.
To create a new palette item, set the
values for the desired vital signs
parameters using the details controls
and click “Save”.

Enter a name for the palette, a
description, and choose color code.
Click “Save” to create the new palette
Item. Palette items are stored in the
active profile.
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When the palette is needed, click the
Load button to select the palette from
the library.

Select the palette item from the “Load
Palette Item” menu and click “Load”

Click the apply option to submit the
changes.

| Premie HAL | User Guide | 31

Modeling (Newborn/Premie)
Use the Hypoxia tab to evaluate the effectiveness of provider intervention on an
apneic patient. The model adjusts the cardiac, oxygen saturation, and cyanosis
dynamically in response to effective ventilations. The model also responds to the
administration of epinephrine and oxygen.

HYPOXIA MODEL STATE
The hypoxia model options improve or deteriorate the cardiac and respiratory
vital signs gradually.


Pause - Model will pause at the current state.



Improve - Trend the vital signs to a healthy state.



Deteriorate - Trend the vital signs to a severe cyanotic state. Ventilations
are detected when the respiratory rate is at 0.

CYANOSIS LEVELS
Select the cyanosis level to move to any of the following states immediately:


Healthy - Pedi is pink with adequate oxygenation.



Mild Cyanosis - Pedi is slightly blue, and the vital signs are starting to
deteriorate.



Severe Cyanosis - Pedi is blue, apneic, and vital signs are rapidly
worsening.
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MODELED THERAPY
The modeled therapy menu provides additional intervention options.


Improve Gain - Adjust the slider to increase or decrease the cyanotic
response to ventilations.



Oxygen - Adjust the slider to administer oxygen to the fetus in liters per
minute.



Epinephrine - Administer epinephrine to the model. Set the epinephrine
dose and then click “add”. Administering epinephrine increases the heart
rate.



Reset - Click “Reset” to clear the oxygen flow and the epinephrine dose
onboard.

| Premie HAL | User Guide | 33

Working with
Premie HAL
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Disclaimer: The content of this table are subject to change without prior notice.
Please contact Gaumard Scientific for the most current information.

Category

Simulator Feature
Nasal Intubation

Airway

Oral Intubation
Breathing/Airway Sounds
Suction exercises

Breathing

Automatic Chest Rise

Independent chest rise

Lung Sounds
Heart Sounds

Cardiac

ECG generated in real
time
Chest compressions
sensor

4 patches

Bilateral IV
Circulation

Fontanel, Brachial, Umbilical,
Femoral

Pulses
Cyanosis
Pedal Vein (left)

Systemic

Frog legs position
Intraosseous access
Temperature sensor

Other

Physiologic Model

Optional

ETC Pro+

Optional

Gaumard Virtual Monitor

Optional

Audio/Video recording and
debriefing
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SUCTION

Airway

Simulate suction technique.

ORAL AND NASAL INTUBATION
Premie HAL’s airway can be
intubated orally using LMA or
endotracheal tubes. Intubate nasally
using a nasogastric tube for
placement exercises.
Procedure

Recommended
Device Size

Intubation
(Blade size)

Miller 0

LMA

Size 1

Nasal
Intubation

8 Fr catheter

Oral
Intubation

ETT 2.5 no cuff, 6
Fr suction catheter

Breathing
RESPIRATORY PATTERN
Use the Detail tab parameter
controls to change the simulator’s
respiratory pattern.
LUNG SOUNDS
Use the Detail tab parameter
controls to change the audible
respiratory sounds on the simulator.

Warning:
Always
lubricate
tubing,
airway,
and
nasal
opening prior to performing any
nasal or oral intubation. Failure to
do so will make intubation very
difficult and is likely to result in
damage.
Do not insert liquids or spray
silicone oil into the mouth and
airway.
AIRWAY SOUNDS
Use the Detail tab parameter
controls to change the upper airway
sounds on the simulator.
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BILATERAL CHEST RISE

Set the respiratory rate higher than
zero to enable automatic bilateral
chest rise and fall.
Disable the right or left lung
individually.
PULMONARY VENTILATION
Ventilate the simulator using a bag
valve mask or a mechanical
ventilator. Set the respiratory rate to
“0” to display chest rise during
ventilation and receive feedback on
the CPR window.

Guide under software
Menu/Help/Instructional Manual.
Warning: Do not physically pace
or defibrillate Premie HAL with
real medical equipment. Doing so
will
damage
the
electrical
components.

Cardiac
HEART SOUNDS
Use the Detail tab parameter
controls to change the audible heart
tones on the simulator.
Heart sounds are synchronized with
the heart rate and selectable cardiac
rhythms.

CHEST COMPRESSIONS
From the CPR trainer window,
monitor the cadence and force of
chest compressions applied by the
provider. For more information on
the CPR trainer, go to digital UNI
User Guide under
Menu/Help/Instruction Manual.

ECG MONITORING AND
ELECTRICAL THERAPY
Conductive skin sites allow the
attachment of real EKG electrodes.
This feature permits the provider to
track cardiac rhythms with real
medical equipment just like with a
human patient.

Circulation
PALPABLE PULSES
Palpable pulses (fontanel, brachial,
umbilical, and femoral) are
dependent on blood pressure.
INTRAVENOUS ACCESS

Use the virtual shock panel to
simulate the administration of
electrical therapy via software. To
enable the virtual shock panel
feature, go to the digital UNI User

Bilateral IV training arms allow for
intravenous infusions as well as
drawing fluids. Use a flashlight to
detect veins in the dorsum of the
hand.
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will keep the fluid inside the
veins.
5. Repeat the procedure to fill the
IV vasculature on the lower leg.
Use a flashlight to detect veins.

Warning: Use only Gaumard’s
provided simulated blood. Any
other simulated blood brand
containing sugar or any additive
may cause blockage and/or
interruption of the vasculature
system.
Follow the steps below to fill the IV
vasculature for drawing fluids.
1. Fill the modified syringe with
water or diluted Gaumard
simulated blood.
2. Connect the syringe into the fill
port and the drain connector to
the drain port as shown.

For simulation of high volume
infusions, it is necessary to
leave the drain tube attached
and run it to a suitable outlet
or container.
INTRAOSSEOUS ACCESS
Establish intraosseous infusions
access to administer fluids and
medications. To use this feature,
follow these simple steps:
1. Remove the skin from the leg to
access tibia bone insert.

3. Slowly push the fluid into the IV
circuit until it begins to flow out
of the drain connector.

4. Remove the fill syringe and drain
connector. The self-sealing ports
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2. Lift the tibia insert out of the
holder.

3. Hold the tibia bone vertically and
inject 2cc of fluid through the
rubber stopper. Air and excess
fluid are purged through the vent
port near the top of the bone.

4. Insert the fluid filled bone back
into the holder.

6. Insert the IO device into the tibia
bone to perform an exercise.
Notice the decrease in needle
resistance as it passes into the
bone marrow cavity. Remove
stylet, aspirate bone marrow,
and infuse fluids.

Following the procedures, aspirate
infused fluids using an empty
syringe through the rubber stoppers.
To extend the life of each bone
insert, seal puncture marks with
cement glue and leave to dry before
re-inserting them into the holder.

Systemic
5. Replace the skin and palpate
tibial tuberosity.

CYANOSIS
Control and program the visible
cyanosis on the simulator. Use the
Model tab to automate the change
in cyanosis as the provider performs
CPR intervention. For more
information on the Model feature, go
to “Modeling” section.
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CATHETERIZATION
Catheterize or inject the umbilical
cord. To fill the umbilical cord with
fluid, inject any of the three blood
vessels with 2 mL of water using the
syringe. For catheterization
exercises, use a 6 Fr urethral round
tip catheter lubricated with silicon
oil.

Warning:
Do
not
remove
umbilical cord while Premie
HAL® is in operation. To remove
the umbilical cord, first turn the
simulator off (by clicking on File,
Exit on the UNI software), or set
the manikin on STAND-BY
mode. Replacement of cords
should also be done while the
manikin is turned off or set on
STAND-BY mode.
TEMPERATURE PROBE
The temperature reading on the vital
signs monitor is displayed when a
temperature probe is placed on the
lower right quadrant of the
abdominal area.
To enable the temperature sensor
detection feature, go to
Setup>Options>Neonate features
Tab. Checkmark “Use temp. sensor”
and click OK to save. The log panel
detects the placement of the sensor.

The replaceable umbilical cord can
be trimmed or cut. Before removing
or replacing the umbilical cord after
an exercise, turn off the simulator by
exiting the software (File>Exit), or
set the simulator on STAND-BY
mode. After the simulator is
powered down, the umbilical cord
can be safely unplugged. For
information about ordering
replacement umbilical cords, go to
the Appendix.
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Other
VITAL SIGNS MONITOR (OPTION)
The Gaumard Monitors touchscreen
display simulates the functionality of
a patient vital signs monitor. Users
can customize the type of
waveforms and scalars displayed,
set alarms, and display lab reports,
x-rays, and other files for the
provider to access during
simulation.
The Gaumard Monitors vital signs
system is available in a mobile and
desktop solution.

PRO + (OPTION)
The Pro+ system is an all-in-one
session recording and simulator
control solution for facilitators in a
lab or mobile environment. The built
in UNI software allows the facilitator
to control Premie HAL while
recording care provider interaction
and event logs. The upgrade
replaces the standard tablet with a
convertible touchscreen laptop
loaded with the Pro+ environment
and UNI, (2) WIFI enabled cameras,
(1) motorized 180 view USB camera
and carrying case.

For more information on using the
Pro + system, refer to the
documentation included with the
upgrade option.

For information on how to setup
Gaumard Monitors with GUI, please
refer to the help File included with
the Gaumard Monitors software.
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Appendix
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More about Scenarios
Factory Preset Scenarios
Name

Scenario
Type

Operating
mode

1 Diabetic Mother

Diabetic Mother

Branching

Manual

2 Ductal Dependant Heart
Lesion

HLHS

Linear

Manual

3 Group B Sepsis and
Secondary Apnea

Group B Sepsis

Branching

Manual

4 Hyaline Membrane
Disease

HMD

Linear

Manual

5 Meconium Aspiration
and Pneumonia

Meconium
Aspiration

Branching

Manual

6 Necrotizing Enterocolitis

NEC

Branching

Manual

7 Normal

Normal

Branching

Manual

8 Patent Ductus
Arteriosus

PDA

Branching

Manual

9 Pneumothorax

Pneumothorax

Linear

Manual

Scenario Title

Meds Profile
1 Adenosine OD

Adenosine OD

Linear

Automatic

2 Adenosine SD

Adenosine SD

Linear

Automatic

3 Adenosine UD

Adenosine UD

Linear

Automatic
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Premie HAL®

Diabetic Mother
A thirty two week infant is born to a 23 year old insulin dependant mother who was diagnosed at age
21. She is classified as Type B and has been followed in the high risk clinic. Suction and stimulation
have already been applied.
Appearance:
Cyanotic, gasping
respirations,
slightly limp

Diabetic Mother 1
HR 140, BP 45/26
RR 40, O2 Sat 83%
Dextrostick 20
A=0
P=2
G=1
A=0
R=2
-----5

Begin BVM with O2
Wait indefinitely for action

Diabetic Mother 2
“5 minutes later”
HR 160, BP 45/26
RR 80, O2 Sat 83%
Transition Time: 1 min

Cyanotic, grunting
and retracting

Transfer to NICU. Treat for RDS.
Give a mini bolus 2ml/kg of D10W
at 1 ml/min followed by an
infusion by peripheral IV
Wait indefinitely for actions

Diabetic Mother 3
HR 160, BP 45/26
RR 72, O2 Sat 88%
Dextrostick 40
Transition Time: 45 sec

Diabetic Mother 4
HR 160, BP 50/30
RR 60, O2 Sat 93%
Dextrostick 53
Transition Time: 30 sec

End

Correct Action
Begin Calcium
Gluconate IV to
treat hypocalcemia

A=2
P=2
G=2
A=1
R=2
-----9
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Check Serum
Calcium

Incorrect Action
Failure to treat
hypocalcemia

A=2
P=2
G=0
A=1
R=2
-----7

Diabetic Mother 5
ST elevation
HR 160, BP 45/26
RR 72, O2 Sat 93%
Dextrostick 53
Transition Time: 30 sec

End

Premie HAL®

Ductal Dependant Heart Lesion
Hypoplastic Left Heart Syndrome
A 32 week premie remains cyanotic despite breathing 100% Oxygen

Appearance:
Pale and cyanotic

HLHS 1
HR 150, BP 60/35
Heart Sound: S4 gallop
RR 80, O2 Sat 83%

Begin prostaglandin E1 infusion
and arrange for transport to a
center that performs cardiac
catheterization and surgical
correction.

Chest X-Ray:
Cardiomegaly with increased
pulmonary blood flow
Action:
Echocardiogram confirms
hypoplastic left ventricle and aorta.

A=0
P=2
G=0
A=0
R=2
-----4
End
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Premie HAL®

Group B Sepsis and Secondary Apnea
A mother with no prenatal care delivers a premature baby with foul smelling amniotic fluid in the
emergency room. The baby is being bagged with O2.

Appearance:
Limp, cyanotic,
EGA 32 weeks

BVM for 15 sec and
then transfer to nursery.
Place on ventilator with
a PEEP of 4 and a rate
of 30, deliver surfactant
and treat sepsis

A=0
P=1
G=1
A=0
R=0
-----2

Place UAC to
monitor ABG,
BP, and deliver
a fluid bolus

Correct Actions
Immediate intubation
with O2

Sepsis 3
HR 110, BP 30/15
RR 30, O2 Sat 92%
Transition Time: 30 sec

Secondary Actions

Same Vital Signs
“15 minutes later”
HR 110, BP 30/15
RR 30, O2 Sat 92%
Transition Time: 15 sec

Sepsis 1
HR 100, BP 30/15
RR 0, O2 Sat 80%
Temp. 37 Deg C

Perform Actions

Death occurs because
secondary apnea is not
reversed by vigorous
ventilatory intervention.

No UAC
(peripheral IV only)

Same Vital Signs
“30 minutes later”
HR 110, BP 30/15
RR 30, O2 Sat 92%
Transition Time: 1 min

Administer Pressor
Wait indefinitely for action
End
Sepsis 4
“15 minutes later”
HR 110, BP 35/28
RR 30, O2 Sat 92%
Transition Time: 15 sec

End
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A=0
P=1
G=1
A=0
R=0
-----2

Incorrect Actions
Continue BVM and
chest compressions

Sepsis 2
“15 minutes later”
Asystole
Immediate transition
after a 1 min wait

End

Increasing the rate of
peripheral IV causes
infiltration and loss of IV
access. Baby deteriorates
to irreversible hypotension
and septic shock.

Premie HAL®

Hyaline Membrane Disease

A teenage mother with no prenatal care delivers a 1300g Infant in L/D

Appearance:
Cyanotic Decreased tone
Tachypnea with retractions

A=2
P=2
G=0
A=1
R=2
-----7

HMD 1
HR 140, BP 50/30
RR 70, O2 Sat 80%

Administer supplemental
oxygen and transfer baby to
the NICU
Wait indefinitely for actions

HMD 2
HR 140, BP 50/30
RR 60, O2 Sat 85%
Transition Time: 20 sec

For mild HMD, consider
nasal c-pap. For severe
nasal c-pap, consider HFV.

Suction and gentle
stimulation in the
radiate warmer has
already been applied

Obtain an ABG and chest
X-Ray. Start a peripheral
IV. Arterial blood appears
slightly dark so you
increase the FiO2

Intubate and administer
surfactant.
Wait indefinitely for actions

HMD 3
HR 150, BP 52/33
RR 55, O2 Sat 94%
Transition Time: 1 min

A=2
P=2
G=0
A=1
R=2
-----7

End
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Premie HAL®

Meconium Aspiration and Pneumonia

A thirty one week infant is delivered with thick meconium stained amniotic fluid.

Appearance:
Cyanotic, limp
muscle tone

Color improves
Active Muscle Tone

Mild

Meconium aspiration1
NSR
HR 100, BP 70/50
RR 0, O2 Sat 70%

Perform endotracheal
intubation. Suction meconium
from below the cords. Gentle
stimulation and warming
Wait indefinitely for actions

Mild / Severe
Meconium Aspiration

Obtain Chest X-ray,
CBC, blood cultures
and start broad
spectrum antibiotics

Severe

Chest X-Ray
shows diffuse
bilateral infiltrates

Appearance:
Cyanotic
Retractions

Meconium aspiration2
HR 140, BP 70/50
RR 40, O2 Sat 85%
Transition Time: 15 sec

A=1
P=2
G=1
A= 1
R=2
-----7

A=0
P=2
G=0
A= 0
R=2
-----4

Meconium aspiration3
Grunting
HR 140, BP 70/50
RR 80, O2 Sat 70%
Transition Time: 15 sec

Reintubate and
add surfactant
therapy

End
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End

Premie HAL®

Necrotizing Enterocolitis
A two week old premature infant began enteral feeds a week ago. He required some resuscitation at
birth for perinatal asphyxia and received antibiotics for possible sepsis. His nurse reports increasing
gastric residuals and a few episodes of apnea and increasing abdominal girths.

Suspect NEC. Order XRays of abdomen. Check
CBC and platelets.
Check stool for blood.
Repeat septic work up.

NEC1
Apnea, O2 Sat 75%
HR 182, BP 75/45

Appearance:
Cyanotic

Pale and lethargic with
abdominal distension.
Abdominal film shows
gas in the peritoneal
cavity indicating
intestinal perforation.

Abdominal film shows
gas in the bowel wall
(pneumatosis intestinalis)

Correct Actions
Stop feeding by
mouth, Start TPN,
and begin antibiotics

NEC2
“2 weeks later”
Resp. Pattern: Normal
RR 55, O2 Sat 96%
HR 161, BP 51/32
Transition Time: 2 min

End

Perform actions

Begin enteral
feeding again

Intubate and provide
ventilatory support.
Treat for shock with
fluid and pressors.
Treat sepsis and
obtain emergency
surgical consult.

Incorrect Actions
Decrease enteral
feeding and delay
physical exam
and X-Ray

NEC3
“24 hours later”
RR 0, O2 Sat 70%
HR 142, BP 75/45
Transition Time: 45 sec

End
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Premie HAL®

Normal
A mother is admitted to the hospital for preterm labor. She has had good prenatal care and her
dates show the infant to be approximately 32 weeks. She received two doses of antenatal steroids,
her membranes are intact and the baby’s Lecithin/Sphingomyelin (L/S) ratio is 1.9:1. She continues
to labor and the baby’s scalp pH is 7.5. Despite attempts to delay delivery she delivers a 1300g
infant. After suctioning and gentle stimulation, the baby begins to cry.
Normal 1
Sinus Rhythm
HR 140, BP 50/30
RR 50, O2 Sat 98%
Temp. 37 Deg C
Dextrostick 70

Appearance:
Acrocyanosis
Active movement

A=1
P=2
G=2
A=1
R=2
-----8

Perform Actions

Correct Action
Supply O2 by blow-by

Reflex bradycardia
results in unnecessary
BVM. Baby is
transferred to NICU for
evaluation and placed
in a oxy-hood with an
FiO2 of 40%

Incorrect Action
Prolonged suctioning
of posterior pharynx
Normal 2
HR 80, BP 50/30
RR 50, O2 Sat 98%
Transition Time: 30 sec

A=1
P=2
G=2
A=2
R=2
-----9

Same Vital Signs
Transition Time: 1 min

A=1
P=1
G=2
A=1
R=2
-----7

Transfer to NICU
Wait Time: 20 sec
Normal 3
HR 140, BP 40/35
RR 80, O2 Sat 98%
Temp. 38 Deg C
Dextrostick 50
Transition Time: 1 min

End

Wean from O2, place
in incubator, begin
enteral feedings with
pumped breast milk or
preterm formula.
Oxygen saturation
remains good with
feeding

Weeks later: In crib, temp.
stable, taking 45cc of
preterm formula or fortified
breast milk every three to
four hours, weight is 2000g.
No apneas or bradycardia.
Consider discharge to home
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Start peripheral IV with
D10W and monitor pulse
oximetry.
Wait indefinitely for actions

Cyanosis
improving

Good color, reacts
to stimuli, and
sucks on pacifier

Normal 4
“24 hours later”
RR 50, O2 Sat 98%
HR 140, BP 40/35
Dextrostick 70
Transition Time: 2 min

End

A=2
P=2
G=1
A=2
R=2
-----9

Premie HAL®

Patent Ductus Arteriosus
On the second day of life, a premie who has had a good response to surfactant and ventilation
develops deteriorating vital signs.

Appearance:
Fair color, hyperactive
precordium and
bounding pulses.
ET tube clear

PDA1
Sinus Rhythm
HR 160, BP 40/30
Systolic Ejection Murmur
RR 42 (Ventilation)
O2 Sat 90%
Grunting Lung Sound
Confirm diagnosis
of PDA with
Echocardiogram

Improvement
after 24 hours

PDA2
HR 140, BP 58/40
RR 42 (Ventilation)
Heart Sound: Normal
Lung Sound: Normal
Transition Time: 30 sec

End

Increase PEEP
Restrict fluids
Begin Indomethacin IV
(up to 3 doses)

No Improvement
results in surgical
intervention

No improvement
after 24 hours

Same Vital Signs

End
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Premie HAL®

Pneumothorax
This 32 week infant had no respiratory effort at birth and required intubation is now on a ventilator
with a setting of 40 The mother had good prenatal care and received two doses of antenatal
steroids prior to delivery.

Appearance:
Cyanotic

Chest film shows the
ET tube in the Right
Mainstem Bronchus

Pneumothorax 1
HR 180, BP 80/52
RR 40, O2 Sat 72%

Withdraw the ET tube slightly
Wait indefinitely for action

Pneumothorax 2
HR 165, BP 65/41
RR 40, O2 Sat 85%
Transition Time: 20 sec

Chest film confirms
development of
tension pneumothorax

Perform emergency needle
decompression followed by
chest tube placement
Wait indefinitely for actions

Pneumothorax 3
HR 160, BP 50/30
RR 40, O2 Sat 95%
Wait Time: 15 sec

End
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A chest X-Ray needs to
be ordered to check the
tube placement.

Consider tension
pneumothorax.
Order repeat film and
try trans illumination.

More about scenarios
THINKING IN TERMS OF PALETTE ITEMS
As described previously, palette items represent complete or partial groups of
settings that have been stored as a single item. Applying partial states will hold
constant all settings that are left unspecified.
Not only does it take time to customize the palette, but a very large palette
becomes difficult to navigate. So, it is desirable to minimize the number of Palette
Items in each Profile. To accomplish this, an experienced facilitator tries to create
items that are as generally applicable as possible and can therefore be applied to
a wide range of scenarios. The key is to include only in your palette items the
settings that are directly related to the physiological event represented by that
palette item.
SMART SCENARIOS
After reading the Details, Palette, and Scenarios sections of this guide, it should
be clear how to build a scenario. You may have already tried building your own
or modifying some of the factory presets. The following four guidelines will refine
your ability to build the best possible scenarios.
1. How will the scenario begin?
The first thing to consider is the initial condition of the patient. Create a Palette
Item to describe this condition. Make sure that this first step in the scenario is a
complete state. That is, indicate some selection for each available setting on the
Status/Details panel. Remember that only the settings you specify will cause a
change in the simulator, and all other settings will remain constant. Therefore, by
starting with a complete state, the simulator’s condition will always be the same
when the scenario starts, regardless of what she was doing previously.
Likewise, the "transition duration" of the first step in the scenario should be zero,
indicating that changes are applied immediately.
There is one point that can cause confusion and warrants further explanation. It
UNIis an extension of the above discussion of partial states. The issue is best
illustrated through the following example:
Suppose that you are creating a Palette Item to start your scenario. In this case,
you have decided that the patient will be apneic. The question is, "How should
the lung sounds be set?"
Most people's first inclination is to set the lung sounds to "none.” This is incorrect,
despite apnea. Obviously, no lung sounds should be heard during apnea, but
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since you have already set respiratory rate to zero, none will be. (Sounds are
synchronized to the breathing cycle.)
What you are really setting here when you choose a lung sound is the condition
of the lungs, given respiratory drive. That is, if the patient's respiratory rate were
changed from zero, what sound would be heard? Assuming that the lungs
themselves are normal in this scenario, you would choose "normal" for the lung
sound setting.
Then, as the scenario progresses, if the patient starts breathing, there will be no
need to set the lung sound again. It will already be set. The same principle
applies to the heart sound and other settings.

2. Include notes to guide the facilitator during the simulation.
It is common for scenario designers, especially those who act as facilitators, to
neglect the importance of notes in the scenario. They think that they will
remember the learning objectives, patient history, and other details at the time
they are ready to conduct the simulation. They usually do not, especially when
revisiting a scenario months after creating it.
When you add "Wait" and "Wait Indefinitely" steps to a scenario, you have an
opportunity to edit the item description. Use this description field to hold notes to
the facilitator. Typically, scenario designers write notes in that space to indicate
what the provider(s) or facilitator should be doing at that point.
Further, when saving the scenario, you may edit the scenario description. This is
the best place to put patient history and any other longer notes and instructions.
3. Assume that providers will do the right thing.
Usually a scenario should be created with the assumption that the providers will
perform correctly. As long as they do, the scenario can be allowed to continue.
Naturally, preparation must be made for what might happen to the simulator
when providers deviate from expectations. The consequences of such deviations
can sometimes be included in the scenario, punctuated by "Wait Indefinitely"
items. In other cases, the simulation will require more direct control by the
facilitator via either the Palette or Status/Details panel.
4. Choose auto-response settings based on the scenario content and the
objectives.
As seen, auto-responses can be used to free the facilitators’ attention. They also
enhance realism by presenting instant reactions to the care providers. On the
other hand, sometimes it is not possible or desirable to determine the responses
before the simulation begins. Different environments and applications call for
different settings.
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Some teaching practices are best done with the auto-response settings in
Prompt mode. Responses must be triggered by a vigilant facilitator. Though it is
slower and requires more attention, the benefit of Prompt over other modes is
that the simulation can be allowed to go in any direction, and it will be possible to
choose the response on a case-by-case basis.
Other learning exercises require a higher degree of automation. For such
applications, most facilitators choose Auto mode for the auto-response settings.
The key issue is standardized timing of symptom presentation. A consistent,
repeatable simulation is essential for fair assessment of that care provider in
relation to others and for the broader interpretation of results in the context of
training validation studies.
When in doubt, it is best to choose Prompt mode, in which the facilitator will be
given direct control of the responses as events are detected
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Troubleshooting
Use the following table to find causes and solutions to a number of possible
problems.
Symptom

Possible Cause

Solution

Communication
never gets
established or is
lost

Battery is discharged

Turn off the software and plug
“charger” adapter to the simulator.
The charger’s LED will turn green
when the simulator is completely
charged. Do not turn on the UNI
software until the charging process
is complete.

(blinking communication indicator is consistently red)

The adapter labeled “Power
Supply” does not recharge the
battery.
Disconnect the “Power Supply” and
follow the charging procedure
explained above.
Computer is too far
away from simulator

Get simulator closer to computer.

RF module is not
connected

Close the UNI software and
connect the USB RF module to the
tablet computer.

Trying to
communicate with a
different simulator

After clicking the UNI icon, select
the name of the applicable
simulator and click “Start”.
On the menu bar go to Setup>
Options> Environment and select
FIXED. Then, enter the simulator’s
serial number in the text box.
Finally, restart the software.

Multiple simulators
are on at the same
time.
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Select different channels for each
of the simulators, and then turn
them on one at a time, meaning:
Wait until a link has been
established between the tablet and

Symptom

Possible Cause

Solution
the simulator (the yellow window
goes away).

Only after that, start running the
UNI software in the second tablet,
and so on for the rest of the
simulators. To do so, go to menu
Setup  Options  Environment
 Select “Auto change to channel:
#” (# = number from 1 – 11).
All others

Close the UNI software and unplug
the RF module for at least 5
seconds, then plug it back in.
Restart the software and wait for
initialization. On the menu bar go to
Setup>Options>Environment and
select FIXED. Then, enter the
simulator’s serial number in the text
box. Finally, restart the software.

Simulator
doesn’t run for
the time
specified on the
manual

Battery not charged,
charger requires reset

Turn off the software and unplug
“charger” adapter from the wall and
the simulator for 1 minute.
Reconnect the “charger” to the wall
and the simulator. Unplug the
charger when the charger’s LED
turns green indicating that the
simulator is completely charged. Do
not turn on the UNI software until
the charging process is complete.

Simulator
doesn’t respond
to any command
even that blinking communication indicator is
consistently
green

The computer is
properly
communicating with a
different simulator.

On the menu bar go to Setup>
Options> Environment and select
FIXED. Then, enter the simulator’s
serial number in the text box.
Finally, restart the software.
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Symptom

Possible Cause

Solution

Commands are
taking longer
than usual to
take effect or
simulator is not
reporting every
action (blinking
communication
indicator is consistently yellow)

Distance between
computer and
simulator is reaching
its limit

Get simulator closer to computer or
move away from obstructions

UNI has set the
power mode to
STAND-BY
automatically

or
there are too many
obstructions between
(walls, etc)
There’s too much RF
interference either
from another
Gaumard tetherless
simulator in the
vicinity or an RF
radiator.

Try changing the RF channel by
going to the menu for Setup 
Options  Environment  Select
“Auto change to channel: #” (# =
number from 1 – 11).

The battery on the
simulator is depleted

Turn off the software and plug
“charger” adapter to the simulator.
The charger’s LED will turn green
when the simulator is completely
charged. Do not turn on the UNI
software until the charging process
is complete.
The adapter labeled “Power
Supply” does not recharge the
battery.

"RF module not
found" message
is displayed
when UNI is
started

RF module not
connected

Connect the RF module to any
USB port.

RF module not
identified by the
computer

Close the software and disconnect
the RF module for at least five
seconds, then plug it back in and
restart the software

Chest
compressions
are not properly
detected or not

Is the communication
indicator panel
consistently yellow?

See solution above in section
making reference to “blinking communication indicator is consistently
yellow”
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Symptom

Possible Cause

Solution

detected at all

Is the respiratory rate
set to “0 / min”?
Chest compressions
are only detected
when the respiratory
rate is set to 0 per
minute (0 / min).
Otherwise they are
ignored

Set respiration rate to zero

All others

See “Calibration Wizard” section
inside User’s Manual

Is the communication
indicator panel
consistently yellow?

See solution above in section
making reference to “blinking communication indicator is consistently
yellow”

All others

See “Calibration Wizard” section
inside User’s Manual

Simulator not running

In some simulators, the trachea is
disconnected from the lungs when
they are not on.

Disable lung/s

Enable the lungs from
“Status/Detail” panel on the UNI
software

Wrong settings or
disabled lungs

Make sure lungs are enabled and
both respiration rate and inspiration
percent are different than “0”. Try
changing the respiration rate to a
different value, and if still nothing
happens, try turning the restart the
simulator.

Artificial
ventilations are
not properly
detected or not
detected at all

Simulator’s
chest does not
rise with artificial
ventilation (e.g.
BVM)

Low chest rise
(or no chest rise
at all) while
breathing

Pre-built

Select “Quick Start Scenarios”
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Symptom

Possible Cause

scenarios don’t
show up

A sound is
absent or is not
heard at desired
volume level

Solution
when starting the software.
Should user forget to do so, there’s
no need to shut down the software
and open it again in order to load
the pre-built scenarios. Go to
“File/Profile” menu and then select
“Modeled Scenarios”

Volume not set to
user’s criterion.
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Every sound has a volume control.
Play with the volume control to get
it to the desired level.

Wireless Network
UNI generates the vital signs
information displayed on the virtual
monitor PC. The information is
transmitted through a wireless adhoc connection between the two
computers in real time.
The wireless settings are configured
at the factory, so no additional
configuration is required.
Use the “Create an ad-hoc Wireless
network” tool to configure the
wireless ad-hoc link between the two
computers. Then, configure the
connection between UNI and the
Gaumard Monitors software.
UNI NETWORK CONFIGURATION
Complete the next steps using the
“Controller - Create Ad-Hoc Wireless
Network” tool built in to UNI
software.

3. Enter a wireless network name
(case sensitive). Use the same
wireless network name to
configure the Gaumard Monitors
PC.
“GaumardNet”
is
the
required name for Windows® 7
computers.

1. From the menu bar, go to Help >
“Create
ad-hoc
Wireless
Network”
The “Controller - Create Ad-hoc
Wireless Network” window is
displayed
2. Select the “Wireless Network
Adapter”. If the wireless adapter
is not listed, first enable the
adapter using the Windows®
network menu and then return to
this window.

4. Click “Set Dynamic IP”.to set the
wireless network dynamic.

5. Click “Apply Wireless Network
Settings” to save the settings.
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6. Restart the computer.

GAUMARD MONITORS NETWORK
CONFIGURATION

After the UNI control computer is
configured, complete the next steps
using the “Create an ad-hoc network
tool” included in Gaumard Monitors
software.
1. On the virtual monitor
computer, click the Gaumard
Monitors icon to start the vital
signs software.
2. Click the V menu near the
top left corner and select
“Create Ad-Hoc Network”.
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The “Virtual Monitor - Create ad-hoc
Wireless Network” window is
displayed.

3. Select
“Wireless
Network
Adapter”. If the wireless adapter
is not listed, first enable the
adapter using the Windows®
network menu and then return to
this window.

4. Enter a wireless network name
(case sensitive). Use the same
name entered in the controller
computer. “GaumardNet” is the
required name for Windows® 7
computers.

5.

Click “Set Dynamic IP”.to set the
wireless network dynamic.

6. Click “Apply Wireless Network
Settings” to save the settings.

7. Restart the computer.

2. Start the UNI control
software.
3. On the UNI menu bar, click
Monitors> Configuration.
The “HAL Virtual Monitor Setup”
window is displayed on the UNI
menu bar, click Monitors>
Configuration.

CONFIGURE THE VITAL SIGNS
BROADCAST

The “HAL Virtual Monitor Setup”
window is displayed.

After the wireless ad-hoc link is
established
between
both
computers, complete next steps to
configure the transmission of the
vital signs information.
1. Verify that both computers
are connected to the
GaumardNet network using
Windows® wireless
connection menu. If the
computers are not
connected, select the
“GaumardNet” network and
click “Connect” manually.

4. Set the adapter to “Wireless
network connection”
5. Verify the network status and
network name, then click
“Connect” to begin
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transmitting the vital signs
information.
6. Write down the “Controller
Name” and “Port number”.
7. Start the Gaumard Monitors
software on the virtual
monitor PC.
8. Click the “V” menu near the
top left corner, and then
select “Comm Setup”.
The “TCP Comm Setup” window is
displayed

software to the Gaumard
Monitors software.
.

9. Click “Connect” to accept the
incoming connection.
4. Repeat the same steps listed
above to connect the UNI
software to the Gaumard
Monitors software.

To connect both computers using a
local internet network, follow the
steps below:
1. Verify that both computers
have applied “Set Wireless
Network Dynamic”. Refer to
UNI and Gaumard Monitors
network configuration
sections for instructions.
2. Disconnect both computers
to the GaumardNet network
and connect them to the local
network manually using
Windows® wireless
connection menu.
3. Repeat the same steps listed
above to connect the UNI
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Replacement Parts
Contact Gaumard Scientific for a complete list of consumables and replacement parts and their
prices. C=Consumables; R=Replacements; A=Accessories; U=Upgrades; M = Factory Repair
ONLY
Item ID

Name

Type

Description

S3009.001

A/C Virtual Monitor

A

A/C Powered 17" Touch Screen monitor and
desktop

S3009.002

D/C Virtual Monitor

A

D/C Powered 12" Touch Screen Mobile
Monitor with stylus

S3009.010

Battery

C

Rechargeable battery

S3009.011

Battery Charger

R

100-240 V AC battery charger with label

S3009.020

Umbilical Cord Kit

C

Set of 3

S3009.023L.M

Lower Left Arm

C

Lower left IV arm, medium color

S3009.023R.M

Lower Right Arm

C

Lower IV right arm, medium color

S3009.026L.D

Lower Left Leg Skin Cover

C

S3009.026L.L

Lower Left Leg Skin Cover

C

S3009.027L.L

Lower Left Leg

R

S3009.029R.L

I/O Leg Skin Cover

C

S3009.031

I/O Tibia Bones

C

I/O Tibia bones

S3009.048

Neonatal Filling Kit

R

Fluid dispensing syringe for Premie HAL

S3009.060

Simulator Transport Case

R

Soft storage and transport case

S3009.080

Simulated Blood Concentrate

C

S3009.081

Silicone Oil

C

S3009.200

Audio & Video Recording
System

A

S3009.204

Tablet PC

R

Wireless tablet PC with stylus control

S3009.205

Bump Case

R

Bump case for tablet PC

S3009.206

RF Module

R

Radio Frequency Module with USB

Oil-based silicone lubricant
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connector
S3009.EXW

Two Year Extended Warranty

A

Extended warranty for years Two AND
Three

S3009.INST

In-Service Training

A

Day of in-service training and installation

Warranty
EXCLUSIVE ONE-YEAR LIMITED WARRANTY

Gaumard warrants that if the accompanying Gaumard product proves to be defective in material
or workmanship within one year from the date on which the product is shipped from Gaumard to
the customer, Gaumard will, at Gaumard’s option, repair or replace the Gaumard product.
This limited warranty covers all defects in material and workmanship in the Gaumard product,
except:
Damage resulting from accident, misuse, abuse, neglect, or unintended use of the Gaumard
product;
Damage resulting from failure to properly maintain the Gaumard product in accordance with
Gaumard product instructions, including failure to property clean the Gaumard product; and
Damage resulting from a repair or attempted repair of the Gaumard product by anyone other
than Gaumard or a Gaumard representative.

This one-year limited warranty is the sole and exclusive warranty provided by Gaumard for the
accompanying Gaumard product, and Gaumard hereby explicitly disclaims the implied
warranties of merchantability, satisfactory quality, and fitness for a particular purpose. Except
for the limited obligations specifically set forth in this one-year limited warranty, Gaumard will not
be liable for any direct, indirect, special, incidental, or consequential damages, whether based
on contract, tort, or any other legal theory regardless of whether Gaumard has been advised of
the possibilities of such damages. Some jurisdictions do not allow disclaimers of implied
warranties or the exclusion or limitation of consequential damages, so the above disclaimers
and exclusions may not apply and the first purchaser may have other legal rights.
This limited warranty applies only to the first purchaser of the product and is not transferable.
Any subsequent purchasers or users of the product acquire the product “as is” and this limited
warranty does not apply.
This limited warranty applies only to the products manufactured and produced by Gaumard.
This limited warranty does not apply to any products provided along with the Gaumard product
that are manufactured by third-parties. For example, third-party products such as computers
(desktop, laptop, tablet, or handheld) and monitors (standard or touch-screen) are not covered
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by this limited warranty. Gaumard does not provide any warranty, express or implied, with
respect to any third-party products. Defects in third-party products are covered exclusively by
the warranty, if any, provided by the third-party.
Any waiver or amendment of this warranty must be in writing and signed by an officer of
Gaumard.
In the event of a perceived defect in material or workmanship of the Gaumard product, the first
purchaser must:
Contact Gaumard and request authorization to return the Gaumard product. Do NOT return the
Gaumard product to Gaumard without prior authorization.

Upon receiving authorization from Gaumard, send the Gaumard product along with copies of (1)
the original bill of sale or receipt and (2) this limited warranty document to Gaumard at 14700
SW 136 Street, Miami, FL, 33196-5691 USA.
If the necessary repairs to the Gaumard product are covered by this limited warranty, then the
first purchaser will pay only the incidental expenses associated with the repair, including any
shipping, handling, and related costs for sending the product to Gaumard and for sending the
product back to the first purchaser. However, if the repairs are not covered by this limited
warranty, then the first purchaser will be liable for all repair costs in addition to costs of shipping
and handling.
EXTENDED WARRANTY
In addition to the standard one year of coverage, the following support plans are available:
Two-Year Extension (covers second and third years)
Call for pricing (USA only)
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Contact Us
E-mail Technical Support: support@gaumard.com
E-mail Sales and Customer Service: sales@gaumard.com
Phone:

Toll-free in the USA: (800) 882-6655
Worldwide: 01 (305) 971-3790
Fax: (305) 667-6085
Before contacting Tech Support you must:
1. Have the simulator’s Serial Number (located in the left leg under the IM site)
2. Access to the simulator and the control computer if troubleshooting is
needed.
Post: Gaumard Scientific
14700 SW 136 Street
Miami, FL 33196-5691
USA

Office hours: Monday-Friday, 8:30am - 4:30pm EST (GMT -4 Summer Time)

Gaumard®, Premie™, and HAL® are trademarks of Gaumard Scientific
Company, Inc.
©Gaumard Scientific Company, 2014. All rights reserved.

All rights reserved.
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